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Promapp Usability 

1. Introduction 

Promapp is an online repository of process information for business users to refer to for 
process guidance, and a base for process improvement. Promapp supports process 
improvement by providing a simple online tool for managing processes – from suggestions, 
through to change management, deployment of changes and notifications for affected 
stakeholders of that process. The tool is specifically designed for ease of comprehension of 
process – the primary (overview) and secondary (work instruction) layers of processes are 
merged via a float-over approach to expose the details of each process step. 

It is aimed at the business users rather than process specialists. There is no traditional 
graphical process mapping tool; process maps are generated off procedure text. Being a web 
application, the major advantage is allowing process information to be more dynamic. 
Publishing to web content is not required; saving changes updates process content in real 
time, even if embedded in many locations.  

Currently, the application is for users in New Zealand, Australia, and Europe, and is in 
English only. Eventually, the company hopes to extend its presence which may create the 
need for other languages. The application is very mature and has been used for 6 years, since 
June 2003. For purposes of this review, the Promapp application was accessed from 
https://go.promapp.com/demo30/view/Login.aspx 

User Profile 
 
Being a heuristic evaluation only, and no access to any prior and detailed user analysis for this 
application, questions were asked of one experienced user of Promapp who provided the 
following information on its typical users:  

The users will have ranging experiences in the business and in the area of process mapping. 
They will have prior knowledge or some exposure to process flows and the business area 
itself. The age range of users is not known (this will be relevant for an issue like font size and 
use of colors in the application). The users will be computer and internet savvy and perhaps 
will multi-task using this tool. The users at each client company are given a half day training 
by Promapp, in the form of a workshop. After this training, they will use the tool themselves 
and populate all the information into it. Promapp will provide support when required.  
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Methodology 
A formal user centered design (UCD) methodology consists of the following steps.  

The Human Factors Specialist in this case is not an advisor to an ongoing development team 
because of which the other steps are not used. Being a heuristic review, it utilizes only the 
steps highlighted in green.  

• Plan project from UCD standpoint 

• Understand organization needs 

• Evaluate current applications 

• Understand users, their tasks and environment 

• Design and build quick prototype on paper or with tools 

• Perform quick tests and iteratively modify prototype until final 

• Check against standards 

• Support development/implementation team 

• Formal usability testing or Heuristic Evaluations 

• Localize and customize application for cultural context 

 

How to Read This Review 
 
The Promapp application seems like an extremely useful tool for those in the area of process 
mapping. The good features, such as the attractive design and graphics, and well-written and 
easy Help text are not discussed in this review; but they are greatly complimented. Since this 
review is meant to uncover any issues with regards to its usability, the write-up will focus 
only on the areas for improvement to provide an enhanced end-user experience.  

Overall usability issues that effect the whole application are first addressed. Next, usability 
issues on a per-page basis follows. Each issue is described and is followed by a 
recommendation. The importance level of each issue is listed in the section’s title within  
brackets, as High, Medium, or Low. Any alphabets from A to P found in brackets refer to the 
table in the next section. Page, label and button names are in italics, and bold is used for 
emphasis. Any highlights in yellow are questions or something that is not clear during 
reviewing. 

 
What does a design recommendation mean? In design, one follows certain rules although 
there is room for creativity. The rules ensure consistency and make it easier for the user.  

Any screens drawn up for showing the recommendations are simply one way to design that 
screen. It does not mean it is the only possible or only correct layout. There will be other 
correct ways as long as the basic principles of design are not deviated from. The basic 
principles are explained in the textual part of the recommendation.
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Usability Criteria and Summary of Findings  
This heuristic evaluation examined Promapp for some or all of the below listed usability 
criteria. The following table is a quick summary of those findings. The alphabets (A to P) are 
used in the body of the report for cross referencing to the category/impact of deviation. The 
rating has been assigned by the reviewer simply as an indication of the overall degree of 
deviation and where the focus of change needs to be for the future. Ratings of 1 to 3 need 
prioritized attention compared to those with 4 and 5. 

To make it easier to for cross reference, it is recommended that Table (1) below be 
printed out and used in reading the report. 

5=Excellent, 4=Very Good, 3=Good, 2=Fair, 1=Poor, NR=Not Rated, NA=Not Applicable 

A Navigation and flow    

B User expectation and transparency(mental model and intuitiveness)   

C User control      

D  User frustration considerations   

E Recovery from errors    

F Status indicators, informative messages, Error messages  

G User Interface design element standards    

H Terminology and language including labeling used     

I Help and Guidance of System (not online Help)  

J Recognition vs recall      

K Effectiveness     

L Functional groupings (related items together separated from 
unrelated)  

     

M Visual design (not including dashboard)      

N Content Accuracy NR 

O Features and functionality      

P Accessibility NR 

 

Table (1)  
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2. Usability Factors in Overall Application 

While the overall usability of Promapp has shown to be acceptable, there are also deviations 
from the principles of UI design which will hinder the user from having the best user 
experience. Due to the nature of the usability issues described in the following 
paragraphs, the most impacts in this section are on Ease of Use, User Satisfaction, and 
Efficiency. 

The following are some of the observations that are pertinent to the application as a whole: 

Browser Dependency (High) (K) 

Currently, Promapp can be used on Internet Explorer. With Firefox usage being at 
approximately 45% as of January 2009, it is recommended that Promapp be designed for use 
on Firefox too (Reference: http://w3schools.com/browsers/browsers_stats.asp) 

User’s Mental Model (High) 

User’s mental model refers to “expectation”. These are based on other familiar standards a 
user is exposed to, or knowledge of the topic and related tasks, or simply a common behavior 
exhibited by several users that points to a certain prediction. 

• Deviations from standard Windows interactions (B, D, F, G): Since the directory 
of folders on the left has the look and feel of Windows Explorer, the user will expect 
the behavior as in Windows Explorer. So the expectation will be to be able to right 
click to create a folder (group), and also to right click on a folder to delete it. 
However, since neither of these actions are not possible in this manner (and with a 
reason), it is recommended that a pop-up message be displayed when the user does a 
right click – the message could advise the user what to do if the user is attempting to 
create or delete a folder. For example, “If you are trying to create a new folder, 
please request administrator. If you are trying to delete a folder, please use the 
Archive functionality via the Edit tab”. 

• Deviation from standard Web interactions (B,D,G): Certain mouse and keyboard 
interactions need to be standard as one is used to on the web. The hand means it is an 
active link that will lead the user somewhere. In many places on the process there is 
a hand and when clicked, it does not lead anywhere. 

• Knowing role and associated rights (D,F): It would minimize any frustration, if the 
user knows upfront what rights have been assigned to him/her and see the 
corresponding list of allowable/not allowable actions. For example, if an average 
user (with no admin rights) starts to build a process and after some time wants to 
delete it, they should have been advised about not being able to delete it bit only 
archive it.  

• Scrolling (B, G, K): If the window is resized to keep it smaller as some users want 
to do, the horizontal and/or vertical scroll bars must appear. This is currently not 
occurring. 
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Font Size (Medium) (D,K) 

It is recommended that there be a method for the user to increase the font size in the overall 
application. This is more important in the main drawing area than in the list of folders 
(groups) on the left of it. Using the browser’s function (via View > Text Size) to change the 
text size does not change it. The font is impacted by what resolution (see next item) the page 
was designed for. The font may be impacted, making it look bigger or smaller.  

Resolution (Medium) (K) 
What screen size is Promapp designed for?  While not designing for a certain screen size is 
not exactly considered a deviation from standard, it is a recommended practice in UI design 
so that most users would avoid scrolling to the maximum extent possible. 

 

Figure (1) 

In this case (see Figure 1) the screen is occupying the entire 14.1” monitor but some lines 
have been cut off, such as-  the heading (Trial Jo), the breadcrumb underneath the heading 
(Promapp > Client Demo > Trial Jo), the Tools and Dashboard. While screen resolution may 
not be the reason for this particular issue, it is important to pay attention to design for the most 
used resolution.  

It is recommended that the page be designed for of 1024x768 which statistically is the most 
frequently used resolution by most users. The page needs to have a fluid design with its 
contents shrinking and expanding with window size to the extent possible. That way it will 
not be as dependent on resolutions, monitor size, how people like to keep their windows 
sized, the number of tool bars they have in their browser etc. 
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Helpful References on resolutions:  
 

http://www.webpagemistakes.ca/most-common-screen-resolution/ 

http://brainstormsandraves.com/mobile/20060801.112153.shtml 

http://www.useit.com/alertbox/screen_resolution.html 

 

Pop-up Blockers (Low) (O) 
Will be useful is the application checks whether there is pop blocker and reminds the user to 
unblock the site. This is a fairly common functionality available on many sites. 
 
 
 

The next few sections detail the page by page usabi lity review of the application. 
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3. Admin 

Use Guidance to Create New Group or Folder (High) ( A,B,I, L) 
Currently, the only way to create a group is to go through the Admin tab on the left of the 
page.   

 

It is suggested that a link to create a new group also be added on the page displaying groups. 
An example is shown in Figure (2). Clicking on this link would take you to the page as shown 
in Figure (3). This would be the same as clicking on the Admin > Group Edit. The link would 
make it intuitive, satisfy common user expectation of seeing all group related functionality in 
one place and also save a click for the user. This would be sort of guidance using a wizard. 

 

   Figure (2) 
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Figure (3) 

  

Sorting Folders (Medium) (G,K) 
The folders within the group edit are not in alphabetical order as seen in Figure (3). 



 

 12

 

Page Focus (Medium) (B,D,K) 
Upon creating the new folder or upon renaming a folder, the focus of the page does not 
remain on the folder we were working with but instead goes to the top of the page. This is not 
a good result when one has to scroll down to get back where they were. 

 

Favorites folder (Low) (J, K,O) 
Add a Favorites folder for improved functionality. 

 

 

Figure (4) 
 

 
 

Adding User (Medium) (A,B,D,K) 
 
• The new record should receive focus or appear as the top row of the page. Currently, it 

appears at the bottom of the list and there may be a need to scroll down the page.  
 
• The navigation which appears at the bottom should also appear at the top. See Figure (5). 

Figure (5) 
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Adding Report Functionality (Low) (K, O) 
Add ability to download the report results to csv and.or xls. Add another box with options on 
screen display to implement this functionality. 
 

 

Figure (6) 
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Labeling (Medium) (H) 
 
Actions on folders happen via the Admin tab as was shown above. Upon clicking on the 
Admin tab on the left side of the page, another page opens up with all the admin related tabs, 
as seen in Figure (7). The labeling of these small tabs could be changed to Users, Groups and 
Permissions without use of the word Edit after each. This is because it will better reflect the 
fact that users, groups, and permissions can not only be edited but also created here.  

Consistency (Medium) (B,L,O) 
When the user is on this page as in Figure (7), it is not apparent that right click has related 
functionality because earlier in the directory folders it did not have the expected functionality. 
Therefore, it is suggested that the right click menu items such as, New Group, Edit Group etc. 
be repeated as buttons on top of the page. This will also be consistent with buttons present on 
top of other pages in the Promapp application.  

 

 

Figure (7) 
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4. Create New Process 

Instruction labeling (Medium) (H) 
 

Logout and Create New Process to be more prominent, maybe use button. 

 

Figure (8) 

 

Use Guidance to Create New Process (High) (A,B,I,L)  
Once within the group, Jyothi Trial, what are the possibilities for the user? The only possible 
action here is to perhaps create a new process. So, there should be a link called Create New 
Process on the page itself (apart from Create New Process being present in the folders 
directory on left) as seen below in Figure (9). This will not only keep related functionality 
together, make it more intuitive and reduce a mouse click; it will also be the start of a 
guidance/wizard.  

 

Figure (9) 
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If there are other possible actions at each level, depending on user rights, they need to be a 
link too. For example, in Figure (10) below, one could add either a group (if user has the 
rights) or start a new process. The links should show up depending on the context and rights. 

 

Figure (10) Context and rights based links 

 

Position of Buttons for Consistency (Low) (G,K,M) 
The Save and Cancel (or Exit Edit Mode, as the case may be) at the bottom of this screen need 
to be positioned immediately after the Objective text field. The white space (blank space 
between Objective and the buttons) serves no purpose. 

 

Figure (11)  



 
 

      17

 

Formatting Toolbar (Low) (O) 
Add formatting toolbar if useful for screen in Figure (11). Formatting toolbars may be available as 
add-ons. 

 

New Process in Draft (High) (B,K,O) 
Within the folder, when a new process is created as a draft, it is not visible on the page below. It 
only shows up in the directory structure on the left of the page. It is not clear if there is any reason 
why draft processes cannot be shown on the page. The recommendation is shown with as a box 
with italicized text (to imply it is a draft) arrow in Figure (12). 

 

 

Figure (12) 
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Ease of Correcting an Error (High) (D,E,F,K,O) 
When a process is inadvertently created under a wrong folder and needs to be moved, the way to 
do it is not simple or intuitive. The first thing one would try is to drag and drop from the old to the 
new folder. The option choose Edit>Process Summary > Select, to accomplish the above is not at 
all intuitive for novice users and is frustrating that the standard interaction does not work.  

 

 

 

 

 

 

 

Figure (13) 

Good usability design suggests that the user is able to remedy errors with ease and get help from 
the system. Make it easy for the user to correct a mistake and reposition the process by allowing 
drag and drop as shown by the arrow in Figure (13). A pop-up window could result from the drag-
n-drop to force the user to enter the reason for change, if necessary.  

Another recommendation would be to change the label on tabs. By process summary, one is 
expecting to see a summary of some kind and does not expect to go to this tab to change directory 
locations. It will perhaps be a better idea to re-label this tab and call it Process Related 
Alternatively, one more tab called Folder or Group Relocations can be created for the purpose of 
moving the process from one location to another. See Figure (14). 

 

Figure (14) 
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5. Create Procedures or Activities 

Wizard (High) (A,B,I) 
The next step is to start creating procedures or activities within the process. The only way to begin 
adding this is to use the Edit button which again is not the place users would look to when they 
want to create something new. It is recommended that a link as seen in Figure (15) be added to 
continue the wizard approach that was started and other reasons mentioned earlier in this report. 

 

 

 

Figure (15) 

Add Activity should lead to the same screen that one would get to via the tabs, Edit > Process and 
Procedure. This screen is shown below in Figure (16). 
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Adding an Activity (High) (A,B,I)  
As shown by the top arrow in Figure (16), it is recommended that additional text instructions 
act as a wizard for help and guidance of what Add Activity will do, what a role means etc. 
(you could also add here that this role will show up on the swim lane in the process flow 
diagram) . These instructions will all disappear once the user begins to add the activity. 

 

Figure (16) 

Selecting a Role (High) (D,I,K) 
It is not clear what needs to be if one cannot find a role in the list of roles available. The 
bottom arrow points to a recommendation on what to do if the role one wants to see is not in 
the list. One Should have an option called Other. If the user makes this choice, a window with 
further instructions could then come up – for example, it could bring up an email window to 
the administrator.  

Or create a new button called Add New Role with the appropriate functionality. 
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End of Process Guidance (High) (A,B,C,D) 
It will be of great use to have the wizard provide guidance on what one must do at the end of 
creating the process. We would exit the edit mode and see the process flow visually. But it is 
not clear what the next step after that is such as moving it from the drafts folder to the active 
folder etc.  

 

Preview Tab or Pane (High) (O,K,M) 
The Edit should have a preview tab so that the process map can be viewed without exiting the 
Edit Mode.  
 
 

 

Figure (17) 
 
 

More Guidance (High) (F,O,K) 
Also, note in Figure (17) that one of the tasks is a decision (Dos tenant receive money or owe 
money?). It is not easy to figure out how to add a decision box (diamond with Yes and No 
options). A question mark must cause the box to come up. 
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Use of the Symbols to Indicate Links (High) (G) 
It is very confusing that when the hand symbol is clicked upon, it leads nowhere. This is 
deviating from standard web practices. It was not possible to capture this image of the hand 
but the arrow in Figure (18) shows where this happens.  

 

 

Figure (18) 
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Suggestions Tab (Medium) (K,O) 
After adding a suggestion, one presses a Save button. Is this sufficient or is there a Send 
button required which will inform the relevant person immediately but showing an urgency 
level? This might be a good feature to add. 

 

 Figure (19) 

 

Dashboard (Medium) (K) 
The expectation from a dashboard is typically gauges and meters than a table. It is not clear 
why the most recent processes such a Complete Tenancy is not visible on the dashboard. It is 
also not clear how to set the urgency to red, yellow or green. 
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6. Conclusion 

The Promapp Application is a very nifty tool for creating process flow diagrams and all the 
information that can be contained in them for business improvement. While has many 
positives with respect to usability, there is still a lot of scope for further improving the user 
experience and minimizing frustration. 

The above study revealed problems with, deviation from UI standards, user expectations, lack 
of informative messages, scope for user frustration and therefore, effectiveness. It was 
repeatedly felt that guidance via a wizard would add a great deal of help and value to the 
application. With regards to navigation, it is felt that learning for a new user can be improved 
at places where the user feels a little lost and does not know what the next step should be. The 
guidance will be one way to aid navigational issues and flow if they are not intuitive or self-
explanatory. The application was not tested for several different types of errors but when the 
reviewer came across one and had difficulty in recovery, it confirmed the lack of messages 
and help in that area which could be extended to other areas of the application for its 
enhancement. Error recovery also brings to focus that there can be some changes in 
terminology and labeling made which will avoid making certain errors. The more minor 
issues had to do with consistency, functional groupings, and visual design. Some extra 
functionality has been recommended but considering that the application is in a mature stage 
and has evolved over years, it was not found to be lacking much in this area. 

The above usability findings impact Ease of Use, Efficiency and User Satisfaction more 
than they affect Ease of Learning. 

While the reviewer was able to give feedback by creating a process, some procedures, and 
tasks, there remains the possibility that not every feature and functionality may have been 
tested which can only happen when one observes how a range of users from novices to savvy, 
use the application for their purposes. However, as a heuristic review it reveals many usability 
issues. These can be further validated and extended if given an opportunity to perform testing 
with actual users. A measure of task completion times and number of errors will provide very 
useful data to improve the usability. Further, we will also be able to contribute more to the 
design of the dashboard by understanding what users are looking for in this respect. 

Keeping this constraint in mind, if further analysis is required, it is advised that the usability 
specialist have access to five users (at least two novices and two experienced) of Promapp 
who can provide insight into their use of the application. Remote usability testing and 
interviews are possible for this purpose. 

 

For any questions on the above report, please call Jyothi at +61 448926226. 
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7. Next Steps 

• Your development team can implement recommendations  

• Once implemented, KnowledgeWorking can provide organize Remote Usability 
Testing. Remote Usability Testing is the preferred testing method when: 

o Testing requires participants in widely dispersed locations. 
o The test requires a large number of participants. 
o There are cost and/or time restraints that limit face-to-face testing 

 
 
 

Please contact Jeevan Joshi on +61 421 05 3870 or 
jeevan.joshi@knowledgeworking.com if you require any additional assistance. 
 

 

 


